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Description 

High-quality facility drawings in AutoCAD software give organizations the information 
they need to assign, redesign, and reallocate space, whether for manufacturing or 
offices. When it comes to computer-aided facilities management (CAFM), there’s one 
tool: AutoCAD. This class will show you the skills you need to use AutoCAD to calculate 
available area, understand which percentage is usable space, and export drawings and 
data for analysis and presentation. Concentrating on the basics, this class will guide you 
through a simple CAFM project, letting you learn at your own pace and develop your 
skills as you go. Shaun Bryant will show you how to set up drawings, define and 
measure areas, set up facilities area tables, and annotate drawings. By the end of the 
class, you'll be able to export the information to applications such as Microsoft Excel so 
that you can analyze the data in a tabular format. 

 

Speaker(s) 

� Owner/lead consultant – CADFMconsultants  
� Prolific blogger – owner of the blog, Not Just CAD! 
� Writer – AUGIWorld, Cadalyst, Redshift 
� Content Author – LinkedIn Learning (previously Lynda.com) 
� AutoCAD & Revit consultant and trainer 
� 29 years of AutoCAD experience 
� 8 years of Revit experience 
� Singer/Songwriter – first album released on iTunes – June 2012 
� Second album being written for release in 2018 
� Has been known to sound like the Geico Gecko 

 
 

 

Learning Objectives 

• Learn how to set up a facility drawing using external references (XREFs) 

• Learn how to use polylines and xData to define areas 

• Learn how to set up area table styles 

• Learn how to find and link area xData to the relevant area table 
 

 

© 2014 Shaun C Bryant (Music) 
Ltd. All rights reserved. 
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An introduction to CAFM 

 

Computer Aided Facilities Management 
 
CAFM is the abbreviation for Computer Aided Facilities Management.  
 
What exactly does that mean? Well, CAFM covers a multitude of things; ranging from getting 
your CAD drawings (DWGs) set up to aid you in managing your spaces and areas in a building, 
and calculating useable areas in a building using the data in the drawing, all the way up to 
Integrated Workflow Management Systems (IWFM), which allows you to manage the workflow 
(process) of the management of our facility, whether that be a commercial building, a museum 
or a hospital, for example. 
 

What is Facilities Management? 
 
Based on the above, Facilities Management (FM) is the process in which a facility is managed. 
As stated above, the facility could be any type of building or site that requires management; 
ranging from buildings, all the way up to factories, or even nuclear power stations. 
 

Using space and area management in AutoCAD 
 
The AutoCAD DWG file format is a graphical database. Behind all the pretty lines, arcs and 
circles, is the incredible xData within each DWG. Every AutoCAD object has its own xData, 
especially polylines (PLINE). A closed polyline has special xData; primarily the area xData and 
the perimeter xData, that can be used for space and area management in the Facilities 
Management environment. You’re using CAD (in this case, AutoCAD) for Facilities Management 
(FM). So, now you get the CAFM thing, right? 
 

Managing your spaces 
 
The spaces in your drawing can be represented by closed polylines which have xData, 
especially AREA xData, which in turn, can be placed as annotation on your drawing in tabular 
format, which can also be exported out as spreadsheet or database data, to applications such 
as Microsoft Excel or Microsoft Access. Thus, you can manage your physical spaces in your 
drawing, by recording their physical areas. 
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Setting up a facilities drawing 

Often, a facilities drawing will be created from a structural or architectural plan, which shows the 
structural/architectural grid, columns, beams and walls, as well as openings such as doors and 
windows. 
 

Using a proprietary titleblock 
 
Your FM drawings reflect you and your team. A good titleblock should ALWAYS be used. Make 
sure your titleblocks are accurate (numerically, alphabetically and grammatically), up-to-date, 
and present the CORRECT project information always.  
 
HINT: There are some great default titleblocks in AutoCAD already. If you haven’t got one, 
consider ‘adapting’ a default one! 
 

Working with the structural drawing (FP) 
 
As mentioned above, your facilities management drawing (which we will call your FM drawing), 
needs to be created from your facilities plan drawing (normally the structural drawing), so that 
will be referred to as the FP drawing. The FP drawing needs to be set up with the optimum data 
needed as it will be referenced in to the FM drawing. Utilize commands such as PURGE to clear 
the drawing data that isn’t needed. For example, a titleblock is not needed in your FP drawing. 
Only use the relevant layers, as you will only need to see the structural information, such as the 
grid, walls and openings, for example. Make sure that the filename of your FP drawing reflects 
its purpose in the facilities management process. Use a filename such as P100-01-FP, where 
P100 is the project number, 01 is the floor number, and FP tells you it is the Facilities Plan 
drawing. The FP suffix could also be a prefix for the drawing filename, if applicable or preferred. 
 

Creating your facilities drawing (FM) 
 
The facilities management drawing you create should be a new drawing with your super-duper 
titleblock. Based on the naming philosophy above, a typical FM drawing would become P100-
01-FM, where the project and floor numbers are the same, but the FM suffix/prefix tells you that 
it is the facilities management drawing, NOT the facilities plan drawing. 
 

Referencing in the structural drawing (XREFs) 
 
AutoCAD has a superb piece of functionality, where you can reference in a drawing in to a host 
drawing. It is like paper-clipping two or more drawings underneath the host drawing. The 
reference drawings underneath the host drawings are often abbreviated to XREFs. This is short 
for eXternal REFerence drawings. 
 
In this case, you would attach our FP drawing (the XREF) to our FM drawing (the host drawing), 
so that you can utilize the structural information on the FP drawing to create the FM information 
we need on the FM drawing. You do this using the Reference panel on the Insert tab on the 
AutoCAD ribbon (see Fig.1). 
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Fig.1 – The Reference Panel on the Insert tab on the ribbon 

 

Managing XREF layers (RENAME) 
 
When you XREF in a reference drawing in to your host drawing, the default layer naming 
philosophy of the XREF layers is something like this: - 
 
P100-01-FP | Structural Walls 
 
In the above example, the XREF drawing is P100-01-FP and the layer name is Structural 
Walls. 
 
Fig.2 shows you the Layer Properties Manager displaying the XREF layer name. 
 

 
 
Fig.2 – The Layer Properties Manager displaying the XREF layer name 

 
If your FP XREF drawing has a long filename, it will make for a long layer name in the Layer 
Properties Manager in AutoCAD, so you can use the RENAME command to rename the XREF 
(not the actual filename, that stays the same). 
 
The XREF shows as a BLOCK in the RENAME dialog box as shown in Fig.3. Select it and the 
full XREF name will show in the Old Name field. Simply rename the XREF to FP- and click on 
OK. 
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Fig.3 – The RENAME dialog box, showing the old name and new name of the XREF (not the filename). 

 
When you now check the FM drawing and look in the Layer Properties Manager, the XREF 
layer name will be shortened to FP | Structural Walls. 
 

 
 
Fig.4 – The Layer Properties Manager displaying the XREF layer with the renamed XREF 
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Getting your FM settings right 

A facilities management project will need accurate drawings. By accurate, this means you will 
need to make sure that settings such as your units are appropriate to the project. You will also 
need to make sure your drawing limits in the AutoCAD modelspace are set appropriately to 
accommodate your facility full-size in the modelspace too. 
 

Drawing units 
 
All your FM (and FP) drawings must use the same unit of measurement for both length and 
angles to maintain consistency. This is essential for accuracy, especially when utilizing the 
xData to calculate areas from the spaces represented by closed polylines in your FM drawing. 
 
Your units are set using the UNITS command. You can type UNITS and press Enter to bring up 
the Units dialog box or select it from the Drawing Utilities section of the AutoCAD Application 
Menu. 
 
Fig.5 shows where you can find the UNITS command on the Application Menu. 
 

 
 
Fig.5 – The Application Menu displaying the Drawing Utilities section with the UNITS command highlighted 
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Fig.6 – The Units dialog box 

 
Your drawing units need to be set to what you will be using throughout your facilities project, so 
make sure everyone in your team is using the appropriate units.  
 
Fig.6 shows the units set to decimal in preparation for a metric millimeters project. This will 
differ depending on what units need to be used (obviously). 
 

Drawing limits 
 
As you may or may not know, the AutoCAD modelspace is infinite. So, to make sure that you 
set the appropriate coordinates in modelspace, so that your project is not a tiny little dot on the 
corner of the screen when you use Zoom All, you need to set your drawing limits.  
 
Sometimes, you may set these limits to known site coordinates, but it does depend on your 
facilities project. 
 
The LIMITS command can be typing in by typing LIMITS and pressing Enter (like the UNITS 
command). 
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You will be prompted for a bottom-left corner coordinate of your limits, followed by a top-right 
corner coordinate. This then defines the ‘rectangle’ in modelspace that you will occupy. To 
zoom to the extents of your limits, simply use Zoom All. 
This may seem a bit mundane and unnecessary, but it is important. If you don’t want to set your 
limits all the time, perhaps consider setting up a drawing template (DWT) file, where you have 
your LIMITS and UNITS already set so that you just start a new FM drawing from the template 
each time. The DWT file will remember the settings and you won’t need to keep setting them for 
each new drawing. 
 

Layer naming strategy 
 
All your FM (and FP) drawings should adhere to the project standards. These standards could 
be project or organization specific or could adhere to the layer naming philosophy in a national 
CAD standard such as the USA’s National CAD Standard (NCS) or, if in the UK, the British 
Standard BS1192 or the AEC (UK) CAD Standard. 
 
Whatever layer naming philosophy you do decide to use, put it in your drawing template file 
(DWT) for the project. That way, it is already in place in any new FM drawings. 
 

Setting gradient fills 
 
Gradient fills are superb for highlighting spaces and areas in your FM drawings. You will find the 
GRADIENT command on the Draw panel in the Home tab on the AutoCAD ribbon. It is on the 
same dropdown menu as the HATCH command. 
 

 
 
Fig.7 – The GRADIENT command on the Draw panel on the Home tab on the ribbon 

 
When you select the GRADIENT command, you will get a contextual tab on the AutoCAD 
ribbon called Hatch Creation. Use this to set your gradient fill settings, such as colors and 
styles.  
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Fig.8 – The Hatch Creation tab content when the GRADIENT command is selected 

 

Setting hatch patterns 
 
Hatch patterns are superb for highlighting spaces and areas in your FM drawings. You will find 
the HATCH command on the Draw panel in the Home tab on the AutoCAD ribbon. It is on the 
same dropdown menu as the GRADIENT command. 
 

 
 
Fig.9 – The HATCH command on the Draw panel on the Home tab on the ribbon 

 
When you select the HATCH command, you will get a contextual tab on the AutoCAD ribbon 
called Hatch Creation. Use this to set your hatch pattern settings, such as colors and styles, 
and hatch scale. 
 

 
 
Fig.10 – The Hatch Creation tab content when the HATCH command is selected 
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Spaces and polylines 

To calculate the areas in your facilities drawings, you need to draw and highlight your spaces 
using closed polylines, and sometimes highlight them further with gradient fills and hatch 
patterns to show space usage. 
 

Why use polylines? (PLINE) 
 
Polylines are used to trace around the spaces on your drawings to calculate the areas of your 
spaces. This can be done because a CLOSED polyline has its own perimeter and area xData. 
The area xData can then be taken from the closed polyline and displayed as annotation on the 
drawing by way of a table or list, and can be exported out to other applications, such as 
Microsoft Excel and Microsoft Access. 
 

Object snaps (OSNAP) 
 
Object snaps (OSNAP) MUST be used when tracing your polylines. This ensures accuracy of 
the space areas. You might think that this is a given, and does not need to be mentioned, but 
have you ever had to revisit a third-party drawing and had to re-draw all the polylines that were 
drawn WITHOUT object snaps being used? 
 

Creating space polylines (PLINE) 
 
Creating space polylines is done in the same way as you would create any other closed 
polyline. You set the appropriate current drafting layer (perhaps it might be called FM-SPACES, 
for example) and trace the outline of the relevant space on your drawing, using object snaps for 
accuracy, as mentioned above. 
 
Something that might need to be considered here, though. You will (normally) be working in a 
flat 2D drawing for this task. At what level are you drawing your closed space polyline? Would 
be it a certain standard level above finished floor level? Do you ignore interior columns and 
partition walls? Do you include interior openings such as doorways and interior window 
openings? 
 
All of this would need to be addressed during the beginning stages of a facilities project so that 
the workflow can be standardized, so that the whole team is drawing space polylines to the 
same standard.  
 
Trust me, you need to set this all up right from the start. It’s a real pain in the proverbial to have 
to go back and edit two hundred space polylines that have already been drawn to the wrong 
standard. 
 

Using different space types (assigning areas) 
 
The best way to maintain your different space types (and assign areas) is layer management.  
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You would set up a different layer for each type of space polyline you are drawing. Typical 
examples might be rooms, vertical circulation, rentable space, non-rentable space and so on. 
In the same way, you would create different layers to assign to your areas too. Consider your 
room spaces. They would normally be used by different departments within an organization or 
company, so you would set up layers for your gradient fills and hatch patterns that highlight area 
usage by each different department. Typical examples of layer names for areas might be; FM-
AREA-SALES, FM-AREA-HR and so on, but your layer names would normally be defined by 
appropriate standards, so they may differ. 
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Defining space areas 

To define the spaces (and areas) on your facilities drawings, there are various tools within 
AutoCAD that you can use to your advantage. You will also need to adhere to whatever project 
standards are in place as well. 
 

Methods of measurement 
 
This was mentioned previously, albeit briefly. There are numerous trains of thought (and 
standards) that reflect your method of measurement when calculating your spaces and your 
areas in an FM drawing. 
 
Since you are using xData to extract the area data, the boundary (the closed polyline) needs to 
be exact and accurate. Numerically, that will always be the case, as object snaps will always be 
used by default. But what about the PHYSICAL properties you are measuring? 
 
For example, you may have spaces that have internal columns. How do you create a space 
boundary with an internal column within the space? Well, you can utilize the REGION 
command. You will find it on the Draw panel on the Home tab on the ribbon. It’s on the flyout 
menu on the Draw panel. 
 
All you need to do is draw a closed polyline around the boundary of the space, like normal. 
Then, you need to polyline each column boundary (even if there is only one column).  
 
 

 
 
Fig.11 – The REGION command on the flyout menu on the Draw panel 
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Once the polylines are drawn, you simply run the REGION command and select the polylines; 
both space boundary and column boundaries, then press Enter. This converts the polylines to 
REGIONS. 
 
The benefit of converting the polylines to regions is that regions also have the same area xData. 
Using the SUBTRACT command, you can now subtract the column regions from the overall 
space region, giving you an exact method of measuring a space with internal columns. 
 

 
 
Fig.12 – A typical region after subtracting the columns from the space boundary 

 
Now it may be that your FM standard might not require you to consider internal columns, nor 
internal walls or partitions, or openings. It all depends on the context of what needs to be 
measured, and what your standard specifies regarding methods of measurement. 
 

Using object snaps and centerlines 
 
All spaces must be created accurately so that your area measurements are exact. To do this, 
you must use your object snaps effectively. Make sure to set your running object snaps to an 
optimum in your Drafting Settings. You can do this from the status bar. Just click on flyout arrow 
to the right of the object snap (OSNAP) icon and select the object snaps you need. All the ones 
you select will have a tick mark next to them (�), indicating that they are ON all the time as you 
are working. These are your running object snaps. 
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Fig.13 – The object snap flyout menu on the status bar, showing running object snaps with tick marks 

 
Using the running object snaps will make your life much easier as AutoCAD will automatically 
find the relevant snaps on your drawings as you work. 
 
It is not a good idea to switch on ALL your object snaps. In fact, it can have an adverse effect 
on your sanity sometimes if you do! Use the ones you use the most. If you need any of the 
snaps that are not switched on as running object snaps, consider using the override object 
snap menu. Simply hold down the SHIFT key and right click on your mouse. You can then 
select any override snap you need and it will override your running object snaps. 
 
HINT: There is a SUPERB override snap called Mid Between 2 Points. Great for getting space 
boundaries to follow along the centerlines of interior and exterior walls! Simply select your two 
points and AutoCAD will automatically find the midpoint between those two points. Cool! 
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Fig.14 – The override object snap menu (SHIFT+right click) 

 
Sometimes you need to follow the centerlines of walls and partitions to create your space 
boundaries. As mentioned above in the hint (Mid Between 2 Points), utilize ALL the tools you 
have available. Another thing to remember is that you don’t have to draw a fully closed polyline 
on the first pass. You can draw parts of the closed polyline as individual parts, and then use the 
Edit Polyline (PEDIT) command to join the parts together. You can Edit Polyline on the flyout 
menu on the Modify panel on the Home tab on the ribbon, or you can just type PEDIT or PE and 
press Enter. 
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Fig.15 – The Edit Polyline command (PEDIT) on the Modify panel flyout menu 

 

Using Draw Order 
 
Draw Order is a great tool that you can use in AutoCAD to assist you with the highlighting of 
spaces and areas. You can select any AutoCAD object; gradients, hatch patterns, solid fills, 
even polylines, and then tell AutoCAD to have them in the foreground of the background. A 
typical example of this would be that you need to edit a space boundary that has a hatch pattern 
as a highlight. You would select the hatch pattern and then right click to bring up the shortcut 
menu. Select Draw Order and then use Send to Back, to ensure that the space polyline is at 
the ‘front’ and can be highlighted for selection and then selected first. 
 

 
 
Fig.16 – The Draw Order command and its sub-menu, on the shortcut menu 
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Using lineweight (LWT) 
 
Using lineweight in AutoCAD is a great way to highlight the space polylines where necessary. 
The easiest way to do this is to apply a lineweight to the relevant space polyline layer and then 
switch on lineweight (LWT) in AutoCAD when you need it. The great thing about lineweight is 
that you can turn it on and off on the status bar by clicking on it to adjust the display on the 
AutoCAD screen. 
 

 
 
Fig.17 – The Layer Properties Manager showing that the FM-SPACES layer has a lineweight applied to it 

 
HINT: You may find that lineweight is not displayed on your status bar. Click on the ‘burger’ icon 
(bottom right corner of the AutoCAD screen – three horizontal lines) and it will bring up the 
status bar display menu. Select Lineweight and it will then be displayed on the status bar. 
 

 
 
Fig.18 – Space polylines on the FM-SPACES layer with the lineweight OFF (as indicated on the status bar) 
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Fig.19 – Space polylines on the FM-SPACES layer with the lineweight ON (as indicated on the status bar) 

 
HINT: You may find that lineweight is not displayed on your status bar. Click on the ‘burger’ icon 
(bottom right corner of the AutoCAD screen – three horizontal lines) and it will bring up the 
status bar display menu. Select Lineweight and it will then be displayed on the status bar. 
 

Creating a space/area legend on your drawing 
 
So that you can easily distinguish spaces and areas on your FM drawings, it is often a good 
idea to set up a space or area legend on your FM drawings. 
 
This is easy to do. Just create a small rectangle on a specific layer, say FM-LEGEND, and then 
fill the rectangle with the gradient fill, hatch pattern or solid fill that it represents. Then, place 
some appropriate text next to the rectangle, stating what it represents, such as Room or Office, 
so that the team see what the space or area usage is. 
 

 
 
Fig.20 – A typical area usage legend on an FM drawing
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Annotating spaces/areas 

To communicate your facilities information on your FM drawings, you will need to annotate 
those drawings. AutoCAD provides you with the tools to do so. 
 

Text styles 
 
Annotation means text. And with text in AutoCAD comes text styles. This is a subjective topic 
and is normally standard driven. Most organizations and companies have their own fonts and 
text styles already set up in their drawing templates (DWT files), so much of the time, text styles 
tend to be preset anyway. 
 
Be aware, though. Text styles can be made annotative and take advantage of annotation 
scaling. This is great when you need consistent text across layout viewports of varying scales. 
Just keep an eye out for the annotative icon on a text style. It looks like a section through an old 
scale rule (for those of you old enough to remember them!). 
 

 
 
Fig.21 – The default Text Style dialog box. Note the annotative icon against the ‘Annotative’ text style 

 

Annotative scaling 
 
Annotation scaling allows you to add numerous annotation scales to modelspace objects, such 
as text. This then allows for consistent representation of the objects in layout viewports of 
different scales. So, if your FM labels for rooms in modelspace use, say, the two annotation 
scales of 1:50 and 1:25, they will display at the same paperspace height in the viewports of the 
same scales in a layout in an FM drawing. 
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This is great way to ensure consistent annotation in all your FM drawings and is often applied to 
text styles in a drawing template file (DWT) so that all drawings use the same annotation 
scaling. 
 

Using text fields 
 
Text fields are superb for FM use. They allow you to grab xData from an object (such as a 
space polyline) and display its area in the FM drawing as text. But here’s the best part. If that 
space polyline is edited in any way and the drawing is saved or regenerated, the text field will 
reflect that change. 
 

Text field settings 
 
You can set up text fields in both regular text (TEXT) and multiline text (MTEXT). There is an 
option on the shortcut menu on the right-hand mouse click for both types of text. When you 
select to place a field in a piece of text you get a weird dialog box that you need to go through 
step-by-step. Here are the steps: - 
 

1. The text needs to be selected. In this example the text is single line text (TEXT) but the 
process is very similar with multiline text (MTEXT) as well. 

 

 
 
Fig.22 – The text has been double clicked on to edit, followed by a right click. Note the ‘Insert Field…’ command 

 

2. As soon as you start the Insert Field command, the Field dialog box will appear. The 
Field category (top left of the dialog box) needs to be set to Objects. 
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Fig.23 – The Field dialog box, with the field category ‘Objects’ selected and ready to be clicked on 

 
3. When you select the category Objects, the dialog box will change. You now have the 

option to select Object in the Field names list in the dialog box. Select it and you will 
see the small Select Object icon towards the top middle of the dialog box. The object, in 
your case, this would be a space polyline to annotate its area on to the drawing. 

 

 
 
Fig.24 – The Field dialog box, with the field name set to ‘Object’ with the Select Objects icon indicated 
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4. Click on the Select Objects icon and you will be taken in to the drawing to select an 
object such as a space polyline. Click on the polyline and you will see the xData from the 
polyline appear in the Field dialog box. 

 

 
 
Fig.25 – The Field dialog box, with the Property set to ‘Area’ with the preview and Additional Format button 
indicated 

 
5. The Property needed in your field is Area. A preview is provided along with format 

(units) settings. The preview in this case is a huge number because the FM drawing 
being used is in metric millimeters and the area is in square millimeters. 
 

6. The Additional Format button allows you to change the format of the square millimeters 
to square meters by moving the decimal place. 
 

7. If the Conversation Factor is changed to 0.000001, you can see that the new preview 
value converts to square meters where the Conversion Factor has moved the decimal 
place. 
 

8. Click on OK to close the Additional Formats dialog box, and the click on OK to close 
the Field dialog box. 
 

9. You will now see the text field value in the single line text. 
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 Fig.26 – The Additional Format dialog box, with the conversion factor and new preview value displayed 
 
 

  
 
 Fig.27 – The finished text field displayed as part of the single line text 
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Using blocks and attributes 
 

Blocks and attributes are great tools to have when working with FM drawings. You can make 
blocks of your room use labels, for example. Create a rectangle with an attribute inside it that 
represents the room use and then you can use that label block, over and over, giving the block 
attribute different values for different room uses. 

 

 

Fig.28 – A rectangle and a room use attribute on layer 0, ready to be made in to a block 

 

 

Fig.29 – The finished room use block with ‘Office” as the attribute value 
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Using blocks and attributes in this way is advantageous as all attributes can be extracted and 
put in to AutoCAD tables, using the DATAEXTRACTION command. 

 

Using text symbols (m², for example) 
 
One of the benefits of later versions of AutoCAD is the TrueType Font (TTF) support. This 
means that you can use appropriate symbols to allow for much easier interpretation of the 
annotation on your FM drawings. 
 
Much of your area calculations and data extraction will be in square units, whether that be 
square meters, square feet, or even square kilometers. Using text symbols allows you to define 
those units in your annotation.  
 
For example, this office has an area of twelve square meters. Representing that in your 
annotation on a drawing using text symbols, it could read like so; OFFICE ROOM AREA = 
12m². 
 

  



 
 

 

Page 27 

Setting up a space/area table style 

So that you can extract data from your FM drawings and then add it to the drawing as 
annotation in an AutoCAD table, you need to set up a space/area table style. 
 

Setting up the space/area table style 
 
Like with most annotation, you need a style for an AutoCAD table. In your case, your 
space/area table. You can find the Table Style dialog box in several ways; you can use the 
flyout menu on the Annotation panel on the Home tab on the ribbon, or you can click on the 
diagonal arrow on the Tables panel title bar on the Annotate tab on the ribbon. 
 

 
 
Fig.30 – The Table Style icon on the flyout menu on the Annotation panel on the Home tab on the ribbon 

 

 
 
Fig.31 – The Table Style diagonal arrow on the Tables panel title bar on the Annotate tab on the ribbon 

 
Clicking on either of these will give you access to the Table Style dialog box. 
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Fig.32 – The Table Style Dialog box 
 

Click on New to set up a new table style. Give your table style a suitable name and click on OK. 
 
You will then be in the New Table Style dialog box. 
 

 
 
Fig.33 – The New Table Style dialog box 
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Setting up the table title 
 
Fig.33 shows you the New Table Style dialog box. You can see top right there is an area in the 
dialog box to set your cell styles with the dropdown menu set to the default for a new table style; 
Data. If you select this dropdown menu, you can change the cell type you want to set up. Click 
on it and you can select Title and using the setting below the dropdown menu, you can set up 
the Title cell settings; General, Text and Borders. 
 

 
 
Fig.34 – This shows the cell style settings for the Title cell in the new table style 
 

Setting up the table headers 
 
Fig.33 shows you the New Table Style dialog box. You can see top right there is an area in the 
dialog box to set your cell styles with the dropdown menu set to the default for a new table style; 
Data. If you select this dropdown menu, you can change the cell type you want to set up. Click 
on it and you can select Header and using the setting below the dropdown menu, you can set 
up the Header cell settings; General, Text and Borders. 
 

 
 
Fig.35 – This shows the cell style settings for the Header cells in the new table style  
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Setting up the table data 
 
Fig.33 shows you the New Table Style dialog box. You can see top right there is an area in the 
dialog box to set your cell styles with the dropdown menu set to the default for a new table style; 
Data. If you select this dropdown menu, you can change the cell type you want to set up. Click 
on it and you can select Data and using the setting below the dropdown menu, you can set up 
the Data cell settings; General, Text and Borders. 
 

 
 
Fig.36 – This shows the cell style settings for the Data cells in the new table style 

 
Once you have all the new table style settings in place, simply click on OK to get back to the 
Table Style dialog box. Set your new table style as the current style and then click on Close. 
 

Inserting the space/area table 
 
To insert your new table with your new style, you need to use the Table command. This can be 
found on the Annotation panel on the Home tab on the ribbon, or in the Tables panel in the 
Annotate tab on the ribbon. 
 
The Insert Table dialog box will open, and you can select the space/area table style you 
previously created in the dialog box.  
 
You can also specify whether you start from an empty table or link to existing data. There is also 
the option to specify a point where the table can be inserted, or specify a windowed area for the 
table to auto-fit in to, should the need arise. 
 
Column and row settings can also be specified, as well as cell styles where you can decide on 
whether Title, Header and Data cell styles can be displayed. 
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Fig.37 – The Insert Table dialog box, where all table insertion settings can be set and defined before inserting the table in 
to a drawing 
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Using the space/area table 

Once you have the space/area table in the FM drawing, you can use the data in the drawing to 
occupy the cells in the table. 
 

Locating polyline space/area data 
 
You’ll remember previously that you were able to use text fields to display and annotate areas 
from the xData of space polylines. You can use the same process to add the same data to your 
AutoCAD table and start to occupy your space/area table. 
 
Using the same text field process, you can add an area to the space/area table. Double click in 
the appropriate area data cell and right click. You will see the option to Insert Field… on the 
shortcut menu. You can also use the contextual Text Editor tab where you will find Insert Field 
in the Insert panel. Use the Insert Field command to add the area value using the text field. 
 

 
 
Fig.38 – The inserted space/area table with the text field data showing the area of the space polyline 

 

Adding space/area attribute data 
 
Previously, it was mentioned that you could use blocks and attributes to assist you in your FM 
drawings. A typical example was room area usage labels, such as OFFICE, for example. 
 
Click once in the appropriate cell in the space/area table. You will see the border of the cell go a 
pale pink/yellow color. Check your ribbon and you will see a different contextual tab called 
Table Cell. You will notice the Block command on the Insert panel. You can also right click and 
use the Insert option on the shortcut menu, where Block is on the sub-menu. 
 
Using this Insert/Block command, you will be greeted by the Insert a Block in a Table Cell 
dialog box. You can use the dropdown menu to select the appropriate block from your FM 
drawing to insert in the cell (in this case, the room area usage label block). 
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Fig.39 – The Insert a Block in a Table Cell dialog box 

 
Making sure that the AutoFit option is ticked, and the overall cell alignment is set to Middle 
Center. When you click on OK, you will find your block is now in the cell in the table. 
 

 
 
Fig.40 – The space/area table with the block inserted in the table cell 
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Exporting the space/area table data 

The data in both the table and the drawing can be exported out to applications such as 
Microsoft Excel or Microsoft Access 
 

Exporting the space/area table data to Excel 
 
You can export the core table data, quickly and easily, in to a comma-delimited file (CSV) 
format. This can then be read quickly and easily by Microsoft Excel or Microsoft Access. 
 
This can be done simply by selecting the table in the drawing and right clicking to bring up the 
shortcut menu. Select Export… on the shortcut menu and you can then choose where to save 
the CSV file. This just gives you the core TABLE data though, not the data associated with the 
xData in the FM drawing. 
 
There is another way of exporting data though and this uses the table style set up previously, 
but gives you much more flexibility with your FM drawing data. This method uses the Data 
Extraction command DATAEXTRACTION. 
 
You can find the Data Extraction command on the Insert tab on the ribbon, in the Data & 
Extraction panel. It provides you with a step-by-step wizard menu driving the data extraction that 
allows you to position your chosen data in a table using the table style you choose. 
 

 
 
Fig.41 – The Data Extraction wizard allows you to choose which objects in the drawing you want data from, such as blocks 
and polylines 
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In Fig.41, you can see step three of the wizard, and as you can see, you can select which types 
of objects you wish to extract data from and this is the xData. So, if the polyline objects were to 
be selected, you could extract space polyline area data in this way if you need to. 
 

Editing the space/area table data in Excel 
 
Editing the data in Microsoft Excel is routine if you know how Excel works, but sometimes as the 
AutoCAD guru that you are, you might not have done any Excel training, but you need an Excel 
spreadsheet set up with all your space polyline area data.  
 
So, this is where all this data extraction is extremely useful. It allows you to get the relevant 
data, in this case xData, out of your FM drawings and provide it to the relevant parties who need 
it. It also puts the data in to formats that allow it to be read by other applications (Excel and 
Access). 
 
What it also does is starts you on the path towards fully-automated CAFM as well. There are 
many third-party FM applications out there, such as FM:Systems and ARCHIBUS to name just 
two. 
 
Preparing your drawings in the way this class teaches you gets your drawings in to a format that 
gets them ready to be used in such third party CAFM applications later, when it is time to 
develop your FM within your company or organization. 
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How did I do? 

� Your class feedback is critical. Fill out a class survey now. 
 
� Use the AU mobile app or fill out a class survey online.  
 
� Give feedback after each session.  
 
� AU speakers will get feedback in real-time. 
 
� Your feedback results in better classes and a better AU experience. 
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LinkedIn Learning is at AU too! 

Use the link to access online training on Autodesk products 
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Thank you for attending my Autodesk University class this year! 

 

Stay in touch! 
 
Email: shaun.bryant@cadfmconsult.co.uk 
 
Twitter: @notjustcad 
 
LinkedIn: www.linkedin.com/in/cadfmconsult 
 
Web: www.cadfmconsult.co.uk 
 
 

 
 
 


